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Intellectual Property and Copyright
This document includes registered and unregistered trademarks. All trademarks displayed are the trademarks of
their respective owners. Your use of this document does not constitute or create a licence or any other right to use
the name and/or trademark and/or label.
This document is subject to copyright owned by Xtralis. You agree not to copy, communicate to the public, adapt,
distribute, transfer, sell, modify or publish any contents of this document without the express prior written consent of
Xtralis.

Disclaimer
The contents of this document is provided on an “as is” basis. No representation or warranty (either express or
implied) is made as to the completeness, accuracy or reliability of the contents of this document. The manufacturer
reserves the right to change designs or specifications without obligation and without further notice. Except as
otherwise provided, all warranties, express or implied, including without limitation any implied warranties of
merchantability and fitness for a particular purpose are expressly excluded.

General Warning
This product must only be installed, configured and used strictly in accordance with the General Terms and
Conditions, User Manual and product documents available from Xtralis. All proper health and safety precautions
must be taken during the installation, commissioning and maintenance of the product. The system should not be
connected to a power source until all the components have been installed. Proper safety precautions must be taken
during tests and maintenance of the products when these are still connected to the power source. Failure to do so
or tampering with the electronics inside the products can result in an electric shock causing injury or death and may
cause equipment damage. Xtralis is not responsible and cannot be held accountable for any liability that may arise
due to improper use of the equipment and/or failure to take proper precautions. Only persons trained through an
Xtralis accredited training course can install, test and maintain the system.

Liability
You agree to install, configure and use the products strictly in accordance with the User Manual and product
documents available from Xtralis.
Xtralis is not liable to you or any other person for incidental, indirect, or consequential loss, expense or damages of
any kind including without limitation, loss of business, loss of profits or loss of data arising out of your use of the
products. Without limiting this general disclaimer the following specific warnings and disclaimers also apply:

Fitness for Purpose
You agree that you have been provided with a reasonable opportunity to appraise the products and have made
your own independent assessment of the fitness or suitability of the products for your purpose. You acknowledge
that you have not relied on any oral or written information, representation or advice given by or on behalf of Xtralis
or its representatives.

Total Liability
To the fullest extent permitted by law that any limitation or exclusion cannot apply, the total liability of Xtralis in
relation to the products is limited to:
i. in the case of services, the cost of having the services supplied again; or
ii. in the case of goods, the lowest cost of replacing the goods, acquiring equivalent goods or having the goods
repaired.

Indemnification
You agree to fully indemnify and hold Xtralis harmless for any claim, cost, demand or damage (including legal costs
on a full indemnity basis) incurred or which may be incurred arising from your use of the products.

Miscellaneous
If any provision outlined above is found to be invalid or unenforceable by a court of law, such invalidity or
unenforceability will not affect the remainder which will continue in full force and effect. All rights not expressly
granted are reserved.
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Codes and Standards Information for Air Sampling Smoke Detection
We strongly recommend that this document is read in conjunction with the appropriate local codes and standards
for smoke detection and electrical connections. This document contains generic product information and some
sections may not comply with all local codes and standards. In these cases, the local codes and standards must
take precedence. The information below was correct at time of printing but may now be out of date, check with your
local codes, standards and listings for the current restrictions.

FCC Compliance Statement
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, the user is encouraged to try to correct the interference by one
or more of the following measures; re-orientate or relocate the receiving antenna, increase the separation between
the equipment and receiver, connect the equipment to a power outlet which is on a different power circuit to the
receiver or consult the dealer or an experienced radio/television technician for help.

FDA
This product incorporates a laser device and is classified as a Class 1 laser product that complies with FDA
regulations 21 CFR 1040.10. The laser is housed in a sealed detector chamber and contains no serviceable parts.
The laser emits invisible light and can be hazardous if viewed with the naked eye. Under no circumstances should
the detector chamber be opened.

FM Hazardous Applications
3611 Hazardous Approval Warning: Exposure to some chemicals may degrade the sealing of relays used on the
detector. Relays used on the detector are marked “TX2-5V”, “G6S-2-5V” or “EC2-5NU”.
Xtralis detectors must not be connected or disconnected to a PC while the equipment is powered in an FM Division
2 hazardous (classified) location (defined by FM 3611).

FM Approved Applications
The product must be powered from VPS-100US-120, VPS-100US-220 or VPS-220 only.

ONORM F3014
ONORM F3014, transport times for all tubes (including capillaries) must not exceed 60 seconds from any hole. This
means that the pre-designed pipe networks that include capillaries cannot be used.

AS1603.8
The performance of this product is dependent upon the configuration of the pipe network. Any extensions or
modifications to the pipe network may cause the product to stop working correctly. You must check that ASPIRE2
approves alterations before making any changes. ASPIRE2 is available from your Xtralis distributor.

AS1851.1 2005
Maintenance Standards. Wherever this document and the AS1851.1 differ, AS1851.1 should be followed in
preference to this document.

European Installations
The product must use a power supply conforming to EN54: Part 4.
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License Agreement
Definitions
In these Conditions, unless the contrary intention appears:
l

l

l

l
l

Documentation means any data, information or documentation supplied or made available to Licensee,
including but not limited to any operating or user manuals or online help documentation relating to the
Software;
Intellectual Property includes all copyright, and all rights in relation to registered and unregistered
trademarks (including service marks), registered designs, registered patents and confidential information
(including trade secrets and know-how), and all other rights resulting from intellectual activity in the
industrial, scientific, literary or artistic fields;
You means any person who installs or uses the Software and any person on whose behalf the Software is
installed or used.
Software means ASPIRE2.
Xtralis means Xtralis AG.

Grant of License
1. Xtralis grants to You a non-exclusive, non-transferable license to install and use the Software and to use the
Documentation strictly in accordance with the terms of this agreement (License).
2. In consideration of the grant of the License, You agree to comply with the terms of this agreement.

Permitted use
You may:
1. use the Software and Documentation strictly to aid in the design of a VESDA installation by providing a
system pipe modelling tool
2. make hardcopies of reasonable portions of the Documentation for your internal use or otherwise as
permitted under copyright laws; and
3. make one backup copy of those parts of the Software that are supplied in electronic form, but only as strictly
required for backup and security purposes.

Restriction on License
You must:
1. not sell, reverse engineer, disassemble, decompile, copy, modify, translate, network, publish,
commercialize, rent, lease, assign, transfer, loan, sub-license or otherwise distribute all or part of the
Software or Documentation, or any adaptation, modification or derivative of all or part of the Software;
2. not disclose the Software or Documentation to any third party without the consent of Xtralis;
3. not use the Software for any unlawful purpose;
4. not allow any employees, agents or any other third parties to do anything inconsistent with the terms of this
Agreement; and
5. not remove, obscure or interfere with any copyright, acknowledgment, attribution, trade mark, warning,
disclaimer statement, rights management information or serial numbers incorporated in or otherwise applied
in connection with the Software or Documentation.

Intellectual Property
All intellectual property rights in the Software and Documentation are owned by Xtralis and or its licensor. You must
notify Xtralis immediately if you know or suspect any unauthorised use, or violation of any Intellectual Property.

Updates
Xtralis may, in its sole discretion, provide You with new versions of the Software or Documentation. Xtralis may
charge You an additional fee for the provision of any new versions of the Software or Documentation, which will
otherwise be provided on the terms and conditions of this Agreement.

Warranties
Xtralis provide the Software 'as is' and to the extent permitted by law, Xtralis excludes all representations and
warranties in respect of the Software and Documentation. In respect of any representations or warranties that
cannot be excluded by law, Xtralis’s liability is limited, at its option, to replacement of the Software and/or
Documentation, supply of equivalent Software and/or Documentation or refund of the purchase price.

Limitation of Liability
To the extent permitted by law, Xtralis excludes all liability (including liability for negligence) for any indirect or
consequential expenses, losses damages or costs incurred by You in any way connected with the Software or
Documentation.
To the extent permitted by law, Xtralis limits it total aggregate liability (including liability for negligence) for any
damage arising under or in connection with this Agreement or the use of the Software or Documentation to the
replacement value of the software.

www.xtralis.com
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Release and indemnity
You release Xtralis and its employees and agents in respect of all liability for loss, damage or injury which may be
suffered by You arising from its use of the Software or Documentation; and
You indemnify Xtralis and its employees and agents in respect of all liability for loss, damage or injury, which may
be suffered by any person arising from that person’s use of the Software or Documentation supplied to You.

Termination
Xtralis may terminate this agreement with immediate effect if You breach this agreement or become subject to any
form of insolvency administration.
Either you or Xtralis may terminate this agreement by giving the other party 14 days' notice in writing.
After the termination of this agreement, You must immediately cease using the Software and Documentation and
erase all copies under your control.
Accrued rights or remedies of either party are not affected by the termination of the agreement.

Waiver
Failure or delay by either party to enforce at any time any of the rights, powers or remedies of this agreement will
not be construed or deemed to a waiver of that party’s rights under this Agreement. A waiver of a right, power or
remedy must be in writing and signed by the party giving the waiver.

Entire Agreement
This agreement records the entire agreement between you and Xtralis, and supersedes all earlier or
contemporaneous agreements and representations about its subject matter.

Applicable Law
This Agreement is governed by the laws of the state of Victoria, Australia and each party irrevocably submit to the
jurisdiction of courts of Victoria, Australia.

Severability
A term or a part of a term of this Agreement that is illegal or unenforceable may be severed from this Agreement and
the remaining terms or parts of the terms of this Agreement continue in force. Email comments about software to:
software_support@vesda.com.

iv
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Document Conventions
The following typographic conventions are used in this document:
Convention Description
Bold

Used to denote: emphasis Used for names of menus, menu options, toolbar
buttons

Italics

Used to denote: references to other parts of this document or other
documents. Used for the result of an action.

The following icons are used in this document:
Convention Description
Caution: This icon is used to indicate that there is a danger to equipment.
The danger could be loss of data, physical damage, or permanent
corruption of configuration details.
Warning: This icon is used to indicate that there is a danger of electric
shock. This may lead to death or permanent injury.

Warning: This icon is used to indicate that there is a danger of inhaling
dangerous substances. This may lead to death or permanent injury.

Contact Us
The Americas

+1 781 740 2223

Asia

+852 2916 8894

Australia and New Zealand

+61 3 9936 7000

Continental Europe

+32 56 24 19 51

UK and the Middle East

+44 1442 242 330

www.xtralis.com
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Introduction to ASPIRE2

ASPIRE2 helps you rapidly evaluate the performance of proposed pipe network solutions.
It allows you to enter site specific information and then automatically test a range of possible sample hole
solutions. ASPIRE2 also allows you to configure the design parameters to suit your local fire codes and
standards. The default settings can also be configured to accommodate installation or materials restrictions
such as hole sizes.
Through the use of ASPIRE2 and the good design principles outlined in the VESDA Pipe Network Design
Guide you will be able to determine good designs, and you can then select the most appropriate design for
your project.
ASPIRE2 allows you to automatically create a bill of materials, an installation data pack (IDP), and a 3D
model of the pipe network.
For ease of access, information on the definition and use of fields in the software is covered in the ASPIRE2
online help. Press the F1 key while on any screen for further details.

1.1

Product Guide

The ASPIRE2 Product Guide has been written for pipe network designers. It will assist you to understand and
use the ASPIRE2 software.
This Guide covers the installation, configuration of default settings and the use of the ASPIRE2 software to
design and test pipe network solutions.
The guide contains information on the possible ways to resolve limitations in a pipe network design, and to
arrive at an acceptable solution.
It is assumed that you have already attended Xtralis accredited training and are knowledgeable about local
codes and standards that apply to system design.
For further information on the theory of pipe network design, refer to the VESDA Pipe Network Design Guide.

1.2

Where Does ASPIRE2 Fit in the Customer Life Cycle?

Before you can successfully use ASPIRE2 you need to:
l
l
l
l

Attend Xtralis accredited training in the use of ASPIRE2
Have a good understanding of the principles of pipe network design
Have a good understanding of the local codes and standards
Conduct a site survey to determine the size, scope and obstructions at the customer site

Once you have completed the ASPIRE2 design you will be able to create a bill of materials and an installation
data pack.

www.xtralis.com
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Features

ASPIRE2 contains the following features:
l
l
l
l
l
l
l
l
l
l
l

Navigation Tree to browse the whole project rather than a single detector
Pipe wizards for the simple set up of common pipe designs
Region specific defaults to suit local pipe specifications
AutoBalance to automatically set hole sizes
Introduction of groups for target sensitivity setting
3D isometric models to aid design and installation
Bill of Materials generated for the final pipe network solution
Installation Data Pack captures the installation information
Commissioning Report to generate all forms used to commission the system
Set multiple detector alarm thresholds within a detector (Pipe Type must be set to Europe)
Sampling Point Sensitivity tab to confirm EN54-20 compliance (Pipe Type must be set to Europe)

ASPIRE2 also has the ability to build your own application defaults which suit:
l
l
l

1.4

Customer design specifications,
Local codes and standards, and
Project conditions.

What ASPIRE2 Can Do

ASPIRE2 will allow designers to;
l
l
l
l
l
l

Design systems with multiple aspirated smoke detector units
Design systems with pipe networks fitted to the sample inlet ports of detectors
Design systems with up to 25 holes per pipe (depending on the detector type)
Design systems which use up to 20 bends per pipe (depending on the detector type)
Design systems containing inlet sample pipe runs with multiple branch points
Set multiple threshold levels within a detector (Pipe Type must be set to Europe)

Remember that while ASPIRE2 can accept very large complex pipe designs, each of the detectors has a
physical limit to the amount of protection they can offer.

1.5

What ASPIRE2 can NOT do

It will not fix a poor design by re-configuring your pipe runs. We trust that you have laid the pipes in a way to
accommodate project requirements. AutoBalance will try different combinations of hole sizes in the pipe and
endcaps.
For information on improving the way you configure pipe runs, refer to the Pipe Network Design Guide and
attend Xtralis accredited training.
ASPIRE2 can check that your design meets your configured set of criteria and defaults but does not check
that these will meet the local codes and standards for the customer site. It is expected that you, as the
designer, will use the correct codes and standards.

4
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Installing ASPIRE2

Copies of the ASPIRE2 software can be obtained from Xtralis. The latest copy of the ASPIRE2 software can
be downloaded from www.xtralis.com.
From time to time the ASPIRE2 range of software is upgraded with new functions. These improvements
come from the results of extensive laboratory research and as a result of customer feedback. We highly
recommend that you update your copy of ASPIRE2 every six months. If you have not updated in the last six
months please download a copy from www.xtralis.com today.
The instructions for installation are slightly different depending on how you received your copy of ASPIRE2.
Close all other programs before installing ASPIRE2 as they may interfere with the installation process.

2.1

System Specification

ASPIRE2 is designed to run on Windows 7, Windows Vista™ and Windows XP Professional operating
systems.

2.1.1

Installing ASPIRE2 from a CD

Insert the CD into the CD ROM drive. Wait 10 seconds, if nothing happens run SETUP.EXE on the CD.
The Installation splash screen will appear. Click Next > and follow the instructions on the screen.

2.1.2

Installing ASPIRE2 from a downloaded file

Double-click on the downloaded file and the installation files will be decompressed onto your computer. The
installation will automatically start and display the installer splash screen, click Next > and follow the
instructions on the screen.

2.2

Running ASPIRE2

Double-click the ASPIRE2 icon on your desktop, or alternatively, select Start | Programs | Xtralis |
ASPIRE2.

www.xtralis.com
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Creating a New Project

Each time you start ASPIRE2 it will automatically open a new project. A project contains the detectors, pipes
and holes required for a project.
Click on the project icon in the tree view and enter the name of the project.

3.1

Adding a Detector

To add a detector to your project, right-click the project name in the tree view and select Add Detector. You
should give each detector a meaningful name so that the installer will easily be able to determine the detector
location. To name each detector, right-click, select Rename Detector and enter the name for the detector.
Use the General tab that appears on the Detector View to choose the settings for the new detector.
When you add extra detectors to a project they will automatically be configured with the default settings of the
previous detector. You can choose to alter these defaults by selecting Tools | System Defaults.

3.1.1

Adding a Note

ASPIRE2 allows you to store information on any element of a design. This information is included in the
Installation Data Pack which will be printed out and given to the installers, so it is useful to include details that
will assist the engineers to correctly identify and install the detector.
To add or edit notes for a detector, right-click and select Edit Notes. Enter the information into the pop up
window and select OK to save the details.

3.2

Adding a Pipe

There are a number of different ways to add pipes to a project. To create the first pipe you can right-click the
detector in the tree view, select Add Pipe and use the Pipe Wizard.
Once the first pipe has been created you can either continue to use the Pipe Wizard or you can quickly and
consistently create duplicates of the pipe using copy and paste. To duplicate an existing pipe, select the pipe
in the tree view, press Ctrl+C. You have now copied all the details of the pipe. In the tree view, select the
detector where you want to copy the pipe, press Ctrl+V.
Remember to name each of the pipes to help the installer install the pipes in the right place. To name a pipe,
right-click on the pipe in the tree view and select Rename Pipe. Enter the pipe name then press Enter. Notes
can also be used to record extra information on an pipe.
To add or edit notes for a pipe, right-click and select Edit Notes. Enter the information into the pop
up window and select OK to save the details. To add or edit notes for an individual subsection of
pipe, click on the relevant cell in the Pipe View and click the Edit Item Note button.
Once the pipe has been added you can modify any aspect of the pipe network to suit your customer
environment. Refer to The Pipe View for details.

3.2.1

Adding Extra Bends

Perform the following steps to insert an extra bend into a pipe.
Select the pipe in the tree view window, select the item where you want the new bend to be
inserted, click the Bend button.
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Changing Pipe Direction

You can change the pipe direction by using a branch, elbow or bend. Perform the following steps to change the
direction of a pipe branch.
Select the pipe in the tree view window, then select the Direction of the bend or elbow. in the Direction column
in the Pipe View window. A drop-down list of directions will open and allow you to select from the following
directions:
Code

Direction

U

Up

D

Down

L

Left

R

Right

F

Forward

B

Back

LD

Left & Down

Table 3-1: Changing Bend or Elbow Direction

3.2.3

Modifying Hole Sizes

Perform the following steps to change the size of a hole.
To modify one hole:
Select the pipe in the tree view window, then select the piece of pipe that contains the hole. Select the hole
from the Hole Diameter column and a drop-down list will offer all the hole sizes that can be used in this project.
To use a new hole size for just this project:
Select Insert | Add a pipe and the pipe wizard will run. Select any type of pipe, then click Next >. In the
Sampling Points section enter the new hole size for the Hole Diameter. If the size you have entered is not
part of the default set of hole sizes a message box will pop up to let you know, and also let you confirm that
this hole size can now be used for other pipes in this project.
To change the hole size for the defaults:
To add a new size of hole to the list for this default, select Tools | System Defaults and enter the new size.

3.2.4

Modifying Pipe Diameter

Reducing the size of a pipe can improve the sensitivity of holes at the end of a pipe network.
To reduce the diameter of the pipe, select the pipe in the tree view window, then select the piece
of pipe where the reducer is to be installed. Select the reducer button, and edit the pipe diameter
size to suit your needs.

3.3

Testing for a Good Design

As you enter the details for the pipe network it is a good idea to frequently save your results. Select File |
Save, enter the name of the project and click Save As.
If you have specifically entered information about the size and distance between holes, click the
calculate button to see if the design meets your design criteria. While calculating if the design will
work, ASPIRE2 will not modify any of your configuration.
If you click the autobalance button, ASPIRE2 will begin automatically modifying your design in an
attempt to optimize the results. There is no undo once this option is run so if you wish to keep your
existing configuration save a copy before you begin.
After Calculating or AutoBalancing your design ASPIRE2 will indicate if your design will work*.

8
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The numbers are color coded, green is good, red requires further investigation. For further information on the
color coding refer to The Colors used in ASPIRE2.
If the design is not accepted, refer to Resolving Common Site Design Problems for assistance in improving
the design.
Note:

* Your design will only be as good as the quality of your site survey.

3.4

Saving your Results

At any point during design you can choose to save the project file. Select File | Save to save. Project files can
be shared with other people. To share your project file with users who do not have the latest version of
ASPIRE2 installed, select File | Save As and save the file as the appropriate version.

3.5

Generating Reports

A complete set of instructions for the installer can be produced by selecting File | Generate IDP. The
Installation Data Pack contains 3D schematics with all the pipe lengths and sizes for the installer to be able to
successfully install the project.
You can generate a BOM (Bill of Materials) by selecting the project and clicking the Bill of
Materials button. The BOM contains a list of the components required to install the project,
individual detectors, and each pipe.
Select File | Commissioning Report to generate a Commissioning Report. The Commissioning Report will
contain all of the forms used to commission your system.

www.xtralis.com
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Creating an Effective Design

While you can put all the site survey information into ASPIRE2 and get an acceptable design, how can you tell
if it is the best design? An effective design requires the designer to have detailed knowledge about many
disciplines. At a minimum you should;
l
l
l
l

l

Have a good understanding of the local codes and standards for the site
Attend Xtralis accredited training
Study the VESDA Pipe Network Design Guide and applicable Application Design Guides
Enter into ASPIRE2 the site survey information which has been gathered using the principles of good
design
Test the results for several different possible designs for the site. This 'What if...' testing process
allows you to test the design under different operating conditions, such as with different hole sizes or
with the use of Auto Balance.

Provided you have configured ASPIRE2 with the rules of your local codes and standards, any 'Green' design
will work. For information on how to configure application defaults, refer to Configuring Your Applications and
Defaults.

4.1

Achieving EN 54-20 Compliance

Note:

EN 54-20 compliance features are only available when your Pipe Type is Europe. Select Tools |
System Defaults | Europe.

EN 54-20 is a European standard which classifies aspirating smoke detectors into Class A, B or C. Class C is
normal sensitivity, Class B is enhanced sensitivity, and Class A is very high sensitivity. The classification
system specifies the maximum concentration of smoke required at a sampling point (to trigger an alarm) and
the maximum transport time. The hole sensitivity target is the maximum smoke level allowable to achieve the
detector threshold setting.

4.1.1

EN 54-20 Defaults

ASPIRE2 uses the transport time and hole sensitivity targets that have been approved for a range of Xtralis
detectors. The tables below show the transport time targets and hole sensitivity targets respectively.
ASPIRE2 allows you to choose multiple threshold levels for one detector. When this occurs, ASPIRE2 uses
the shortest transport time of the selected classifications. ASPIRE2 indicates which classes a detector
complies with.
If any sampling holes do not meet the target hole sensitivity, ASPIRE2 displays the detector threshold level
needed to achieve target hole sensitivity. You may choose to apply the recommended detector threshold
level. You may also manually modify the transport time or target hole sensitivities. If those values render the
detector non-compliant, ASPIRE2 displays the hole sensitivities in red text.
Detector

Class A

Class B

Class C

VLP/VLC

60

90

120

VLF-250

60

60

60

VLF-500

90

90

90

VLS

75

75

90

Table 4-1: EN 54-20 transport time targets (seconds)
Detector

Class A

Class B

Class C

VLP/VLC/VLF

1.5

4.5

10

VLS (non-scanning)

1.5

4.5

10

Table 4-2: EN54-20 target hole sensitivities (%obs/m) used by ASPIRE2
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Multiple Threshold Sensitivity

ASPIRE2 allows you to specify a particular detector threshold class to achieve EN54-20 compliance.
ASPIRE2 will calculate the hole sensitivity needed to achieve compliance. You may also specify multiple
threshold levels for each detector (for example Alert = Class A, Alarm = Class B and Fire 1 = Class C) so that
very early warning of low levels of smoke occurs. Table 4 shows the default detector alarm threshold used by
ASPIRE2. ASPIRE2 allows you to choose which detector alarm thresholds are displayed and printed.
Selected thresholds are printed in the installation data pack and on the commissioning form (the Fire 1
threshold is always displayed and printed). The threshold levels must increase in the order Alert < Action/PreAlarm < Fire 1/ Fire < Fire 2. The difference between two thresholds must not be less than 0.005% obs/m. The
minimum Alert threshold value is 0.005 % obs/m (0.025 % obs/m for VLF detectors).
Threshold Level

Default Detector Alarm Threshold

Fire 2

2.0% obs/m

Fire 1/Fire

0.2% obs/m

Action/Pre-alarm

0.14% obs/m

Alert

0.08% obs/m

Table 4-3: The default detector alarm thresholds used by ASPIRE2

4.1.3

Hole Aggregation

When a sampling hole is not able to meet the required hole sensitivity target, you may choose to aggregate
holes. The hole aggregation option allows you to aggregate holes so that smoke detected across a set of
aggregated holes (with clean air at other holes) will trigger an alert. This allows the detector to respond earlier
when smoke is present across a wide area. ASPIRE2 calculates the number of holes that need to be
aggregated to achieve target sensitivity.
Refer to The Sampling Point Sensitivity Tab of the Detector View for more information.
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Advanced Design Using Groups

The concepts and best practices used in this section are for system designers who wish to have a more
detailed technical understanding of the ASPIRE2 software. These features should only be used after you
have attended Xtralis accredited training.
The use of groups allows a collection of holes to have the same performance target. In large sites you may
wish to use a standard configuration for ease of installation. In this environment group the holes which perform
a similar task and the Auto Balance will treat them exactly the same and limit the number of combinations it
will test.
Legend
A

Normal Protection

B

Group over air grille

Figure 4-1: Grouped holes
Groups can also be used for a collection of holes that are in a slightly different environment to the other holes
in the pipe network. So, if you have pipes which are protecting a room, and also have four holes over an air
grille, you can group the air grille holes so they are treated consistently. Groups can be used if you require a
different aggregate sensitivity at a return air grille to the ceiling.
Normally you would treat all holes in a pipe network as a single group. The use of groups allows you to flexibly
assign holes to groups and place different aggregate sensitivity constraints on each group.
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Resolving Common Site Design Problems

AutoBalance may return a number of concerns about the proposed pipe network design. The following
information explains each of the concerns and provide suggestions on how to resolve the issue.

5.1

The Group Sensitivity Needs to Improve

The aggregate sensitivity of a group of sample holes has dropped below your target sensitivity.
l

l

l

5.2

Check that the target sensitivity is correctly set, it may be that your default settings are set too high
and a lower sensitivity is acceptable.
Check to see that the sample points outside the group are not extreme and that a relatively consistent
hole size has been used. The group sensitivity may have dropped due to the sensitivity of other points
being too high.
Check that you have selected the right number and set of sample points.

The Transport Time Needs to Improve

It will take too long for a smoke sample to travel from the sample point to the detector. Transport time is the
time taken for smoke entering a sample hole to reach the detector. It does not include the detector alarm delay
period, which can be configured for each detector.
l

l

l

l

Check that the target transport time is appropriate for this design. Many local codes and standards
require a maximum transport time of 90 seconds. The VESDA laser detector default for systems
typically require the sample to be detected within 60 seconds. If your transport time is between 60 and
90 seconds, check to see if the transport time is acceptable to your local codes and standards.
VLP and VLS detectors allow you to increase the aspirator speed which will increase the speed of air in
the pipe network. To change aspirator speed select the detector in the tree view, if the aspirator speed
is displayed in the details panel, increase the speed and recalculate the design or use AutoBalance to
see if the transport time is now acceptable.
Using larger holes in the pipe endcaps will improve the transport time (but may lower the sample point
sensitivity for all holes in the pipe).
Shortening the length, and increasing the number of pipes covering an area will normally reduce the
transport time.

If the system has already been installed and you are using ASPIRE2 to troubleshoot you should also check:
l

l
l

5.3

That the pipe network that has been installed matches the pipe network that has been designed and
tested in ASPIRE2.
All of the holes have actually been drilled, and are in the right location.
For breaks or blockages such as excess glue in pipe joints.

The Flow Balance Needs to Improve

Flow Balance is needed because sensitivity varies from one hole to another. If all holes are the same size, the
flow rate through each hole reduces with distance from the detector, many designs offset this by increasing
hole size as distance increases. The balance is defined as a ratio of flows, the hole with the least flow is
compared with the hole with the largest flow. So a balance of 70% means that every hole has at least 70% as
much flow as the best hole.
l

l
l
l

l

Check that the size of the sampling holes used is relatively the same. A small increase in the size of
holes is to be expected as you get further away from the detector. Large differences in holes size will
need to be reviewed to improve the balance.
Use the AutoBalance functions to determine the appropriate hole size.
Reduce the size of the endcap hole.
If the pipe has a collection of sampling points in the pipe and capillaries, remember that the holes will
need to be slightly larger than the hole size used in the pipe.
You could also try a different pipe configuration (for example, use an H configuration instead of one
long pipe).

www.xtralis.com
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The Minimum Hole Flow Needs to Improve

There is not enough air being sampled from some sample holes. ASPIRE2 is warning that the sensitivity of
the hole will be prone to fluctuation as a result of air currents in the protected environment. Hole Sensitivity is
the smoke level required at a particular sample point - assuming clean air at the others - to produce a fire alarm
at the detector. Notice that as this number increases, the detector requires more smoke - so the system is
less sensitive.
If a hole has low flow you can improve the sensitivity by adjusting that field on the detector view.
l

l

5.5

Check the hole sizes being used. Increasing the hole size and re-calculating should resolve this
problem.
VLP and VLS detectors allow you to increase the aspirator speed and the flow of air in the pipe
network. Select the detector in the tree view. If the aspirator speed is displayed in the details panel
increase the speed and recalculate the design or use AutoBalance to see if the transport time is now
acceptable.

The Minimum Hole Pressure Needs to Improve

There is not enough air being sampled from a sample hole(s) due to lack of air pressure. Low pressure may
also make the sample flow vulnerable to cross draughts.
l

l

l

l

5.6

Check the hole sizes being used. Decreasing the hole size and re-calculating should resolve this
problem.
VLP and VLS detectors allow you to increase the aspirator speed and increase the speed of air in the
pipe network. To change the aspirator speed, select the detector in the tree view; if the aspirator speed
is displayed in the details panel increase the speed and recalculate the design or use AutoBalance to
see if the minimum hole pressure is now acceptable.
The pipe may be too long. If the pipe is protecting a room, try using an H configuration pipe network
instead.
There may be too many holes for the type of detector chosen. Either select a more powerful detector or
add another detector to the project.

The Hole Sensitivity Needs to Improve

Hole Sensitivity is the smoke level required at a particular sample point - assuming clean air at the others - to
produce a fire alarm at the detector. Notice that as this number increases, the detector requires more smoke so the system is less sensitive.
l
l
l
l
l
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Relax the Target Hole Sensitivity
Lower the EN 54-20 target classification, for example, from A to B (Pipe Type must be set to Europe)
Increase the hole sizes
Decrease the detector threshold
Reduce the number of holes
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The ASPIRE2 Interface

This section contains information about each of the components of the interface and how to work with them.

6.1

The ASPIRE2 Window

Legend
A

Menu Bar

B

Toolbar Buttons

C

Tree View

D

Details Pane

Figure 6-1: Project Screen of ASPIRE2
l
l
l

l

l

Title Bar : Shows the software name.
Menu Bar : Shows the available menus. Refer to The Menus for further information.
ToolBar Buttons : Offers a faster way to perform alterations without having to use the Menus. Place
your cursor over the button for popup information on each button. Refer to The Toolbars for further
information.
Tree View : Shows the current configuration of the proposed project. As you add extra detectors and
pipes this view will change to reflect your changes. Refer to The Tree View for further information.
Details Pane : This window presents different sets of options to allow you to configure the pipe
network. For details on the options presented on the first screen, refer to The Detector View.

6.1.1

The Tree View

Figure 6-2: The Tree View
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The Tree View allows you to browse across all of the detectors and pipes that will be used in the project.
Being able to look over all the details that are used in a project site allows you to cut and paste sections to
rapidly and consistently build new sections of a customer site. An example of what may appear in your Tree
View is shown below.
Project
The project has a red cross next to it as one of the pipes for Detector 3 is unacceptable. All detectors and
pipes must be within your design criteria for the project to be accepted.
Detector 1
This detector has had some modification to its pipe work and the project has not been recalculated
yet. Select Tools | Calculate or Tools | AutoBalance to see if the modifications are within your
design criteria.
Detector 2
This detector and its pipe network have been tested and found to be acceptable.
Detector 3
The pipe connected to detector three is outside your design criteria. You need to investigate, modify the pipe
network (or your defaults) and recalculate to clear the cross.
Detector 4
The pipe connected to detector four is acceptable but close to the limit.
Note:

Use the tree view to quickly rearrange sections of your design by clicking on a section, dragging it
to the desired location, and releasing the mouse button (drag and drop).

6.2

Interacting with the ASPIRE2 Interface

There are many ways of performing actions in ASPIRE2, for example if you want to duplicate an existing pipe
on a detector, select the pipe then;
l
l
l

click the Copy button, select the pipe in the tree view and click Paste
click Ctrl+C, then select the detector and click Ctrl+V
select Edit | Copy, select the pipe, then select Edit | Paste

You can place the pipe in the desired location using the drag and drop feature.
To keep things simple, this document will only describe one method of performing a particular action. It is
anticipated that you may discover other ways to perform an action that you may prefer to use.

6.2.1

The Colors used in ASPIRE2

While working on a site plan you will see that different figures appear in different colors. The colors are used to
let you know if a figure is acceptable, not acceptable, suspect, or not applicable.
l
l
l
l

l
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Green : The figure is acceptable and within the parameters you have set for the project.
Blue : The value is unknown.
Red : Indicates that the figure is outside the parameters you have specified for your project.
Amber/Orange : This figure is not good or bad. You may be pushing the boundaries of your project and
should proceed with caution.
Black : This figure is used to indicate a value setting that does not require validation.
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The Menus

Menus can be accessed at the top of the ASPIRE2 screen.

6.3.1

The File Menu

The file menu allows you to create new project files, open existing files, and save the files you are working on.
This detector has had some modification to its pipe work and the project has
not been recalculated yet. Select Tools | Calculate or Tools | AutoBalance
to see if the modifications are within your design criteria.
The Generate IDP (Installation Data Pack) option provides an easy way to
gather and store all the information that the installers will need to install the
pipework and commission the system.
The Generate BOM (Bill Of Materials) option provides an easy way to create a
list of all the materials required to install your project.
The Commissioning Report option generates a report containing all of the
forms used to commission the system.
Exit will close ASPIRE2.

6.3.2

The Edit Menu
The Copy and Paste functions allow you to duplicate any detector or pipe
configuration. The Paste Insert function allows you to duplicate an item inside
a pipe network (such as a hole or bend). These functions can help you rapidly
and consistently build a complex model by duplicating sections of an existing
design.
The Edit Notes and Rename options allow you to add extra information to
different sections. The name of each section and any notes will be printed out
on the IDP and will assist the person installing the system.
Delete Detector/Pipe/Section lets you remove sections of the project.

6.3.3

The View Menu

The view menu allows you to display or hide the The Shortcut Toolbar and The Palette Toolbar. Refer to The
Toolbars for further information.
3D View : selecting this option will allow you to see a 3-D view of the detector
and pipework. These models can be used to visualize the pipe network.
Scan : The VLS model has the ability to test samples from all pipes and then
scan each individual pipe once smoke has been detected. If you have chosen
to use a VLS you can use this option to test your pipe network with scanning
enabled (ticked) or disabled (no tick). We recommend that you use the detector
in normal mode (no scan) first, then turn scanning on later. For further
information on Scanning detection see the VLS Product Guide.
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The Insert Menu
Adding a detector is one of the first functions you will need to perform when
designing a new site. If multiple detectors are required for a site you can add
further units by selecting this option.
Once you have added a detector you can add pipe runs to suit your site
conditions. Selecting Add Pipe will start the The Pipe Network Choice Screen
of the Pipe Wizard. For further information, refer to See "The Pipe Network
Choice Screen of the Pipe Wizard" on page 33.
For assistance see the VESDA Pipe Network Design Guide and See "Creating
an Effective Design" on page 11.

6.3.5

The Tools Menu
l

l

l

l

l

l

6.3.6

The Help Menu
l

l
l
l
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Calculate: Once you have made changes to your pipe network you can
recalculate the ASPIRE2 figures by selecting this option.
Auto Balance: This is one of the main features of ASPIRE2. Once you
have built your basic pipe network design for the site you can use this
feature to automatically set your hole sizes. It will test a range of hole
sizes, hole numbers and endcap sizes then adjust these setting to offer
the most effective solution for this pipe network configuration based on
the application defaults.
Reject Configuration: If you have entered your configuration for the
pipe network and then tried an AutoBalance, this option will allow you to
reject the AutoBalance suggestion and return to original configuration. If
you select an AutoBalance and then make any changes to the detectors
or pipes, it is assumed you want to keep the AutoBalance configuration
and your original configuration will be lost.
System Defaults: If you are regularly creating similar types of pipe
network designs you can create a set of defaults so that future designs
are created more efficiently, and more consistently. For further
information, refer to The Edit System Defaults Dialog.
Language Setting: This allows you to configure ASPIRE2 to use
different languages.
Application defaults: This allows you to set up default sets for
applications that you commonly use. For further information, refer to
Configuring Your Applications and Defaults.

Contents: Selecting the contents option will display the table of
contents for the online help for ASPIRE2.
Help: Displays the first page of the online help system for ASPIRE2.
Contact us: This option displays the contact details for support.
About ASPIRE2: Displays the version details for the copy of
ASPIRE2 that you are currently running.
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The Toolbars

There are two toolbars available in ASPIRE2. To enable or disable the toolbars, select the View Menu and
toggle the shortcut or palette toolbar options.

6.4.1

The Shortcut Toolbar

Displays some regularly used features.
Create New Project : This button allows you to create an entirely new pipe network project. Please
save your existing work before opening a new project.
Open Existing Project : This button allow you to open existing ASPIRE2 configurations.
Save Design : This button saves your current project configuration. If you have not already saved a
copy of the file, you will be prompted for the location and file name where the design is to be stored.
Generate Installation Data Pack : This button allows you to get an Installation Data Pack so that the
installers get all the details of your current pipe network design.
Generate Commissioning Report : This button allows you to generate a Commissioning Report that
contains the forms and information used to commission the system.
Copy Current Selection : The copy and paste buttons allow you to duplicate any detector, pipe
configuration, or section of pipe. This function can help you rapidly and consistently build a complex
model by duplicating sections of an existing design.
Place item into Design : The copy and paste buttons allow you to duplicate any detector or pipe
configuration. This function can help you rapidly and constantly build a complex model by duplicating
sections of an existing design.
Insert Item Before Current Selection : This button allows you to paste a copied item before your
selected item in the pipework tab.
Calculate : Once you have made changes to your pipe network click this button to recalculate all of the
ASPIRE2 figures based on your current parameters.
Auto Balance : If you have entered the details of your proposed design and the calculate function is
returning Amber/Orange or Red results, selecting this button will cause ASPIRE2 to automatically
adjust hole size settings to see if a better configuration is possible. Auto Balance will test a variety of
hole sizes, hole numbers, endcap sizes and flow rates.
Generate Bill Of Materials (BOM) : Once you have designed an efficient design you can use this
feature to automatically create the Bill of Materials for the project or detector.
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The Palette Toolbar

Allows you to insert different components into the pipe network. The components in this toolbar will change to
suit different regions.
To insert any element, select the location in the project tree window, then click the component. Adding bends
and other joints that redirect airflow disturb the normal air flow inside the pipe network. For information on the
impact of using different types of joints please see the VESDA Pipe Installation Guide.
Add Detector : This button allows you to add a detector to your site design.
Add Pipe : This button allows you to add extra pipes to a detector in your site design.
Edit Item Note : This button allows you to add notes to any element of the pipe network design. These
notes will be included in the IDP (Installation Data Pack) which can be given to the installers. Use notes
to name and help the installers distinguish between different pipes.
Delete Item : This button lets you remove elements from your pipe network design.
Add Bend : This button lets you add a bend to your pipe network design.
Add Elbow : This button lets you add an elbow to your pipe network design.
Add HASP : This button lets you add a Heat Activated Sampling Point.
Add Hole : This button lets you add a hole to your pipe run.
Add Reducer : This button lets you add a pipe reducer to connect different sized pipes.
Add Capillary : This button lets you add a capillary to your pipe network design.
Add Small Radius Bend : This button lets you add a small radius bend to your pipe network design.
Add T Piece : This button lets you add a T piece to your pipe network design.
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Views

The following views are available in ASPIRE2. Some views are only available when a specific type of object
is selected.

6.5.1

The Project View

Figure 6-3: Project View
This is the first screen to be displayed when starting a new project. It allows you to record administrative
information about the project.
l

l

l

l

l
l
l

l

l

Project : This field stores the name of the project. If you use File | Save As to save a copy of this
project the name in this field will change to reflect your changes. Refer to The Edit System Defaults
Dialog for details.
Address : The address of the customer site. Enter enough detail for the installer to install the system
in the correct location. If there are multiple buildings or levels within buildings then these details should
also be recorded to reduce the chance of errors occurring.
Pipe type : Some designers have asked for a way to group designs into different pipe types to help
them manage the customer sites. America, Europe and Asia/Pacific are listed by default. Refer to The
Edit System Defaults Dialog for details.
Contact : Enter the contact details of the customer who will make the final decisions on the fire
systems to be installed.
Date : By default this field records the date when the project was first started.
Installer : Allows you to record who will be installing the system.
Calculated By : Allows you to record your name so that if people look at the project information at a
later date and have any questions they will be able to contact you. You can use this field to also record
your phone or email address to make it easier for the installers to contact you.
Units : Show if you are currently using US imperial or Metric units of measurements. Refer to The Edit
System Defaults Dialog for details.
Altitude : The altitude above sea level affects the air pressure in the detector view. Thinner air at
higher altitudes will increase the time it takes to get a smoke sample to the detector (transport time).
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The Detector View

The Detector view displays all the information about the detector selected in the tree view.

The General Tab of the Detector View

Legend
A Detector selected

B List of available detectors

C Aspirator speed

D Application

E Endcap usage

F Detector details

G Inverted detector selection

Figure 6-4: The General tab of the Detector View
l

l

l

l
l

l

l

l
l

l

l
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Detector Type : This list allows you to select the type of detector for your customer site. As new
detector models become available you will be able to select them from this list. If you are looking for a
particular model and it is not listed, please update your copy of ASPIRE2 to the latest version.
Detector Name : This field displays the name of the detector you have selected. If your customer site
requires pipe networks for an office, atrium, and warehouse you can name each different detector to
avoid confusion.
Aspirator Speed : Some detector models allow you to adjust the aspirator speed. Increasing the
aspirator speed will normally reduce the transport time for smoke samples reaching the detector.
Endcap Usage : Endcap usage determines how you wish to use endcaps.
Create a balanced design : This increases the sensitivity of detection for each hole as more air
comes into the pipe network through sample holes rather than the endcap vent. By default 2mm holes
are used.
Use endcaps to reduce transport time : This option increases the hole sizes in the endcaps so that
the air from the sample holes is transported faster to the detector. By default 4mm holes will be used.
Application : If you find that you are regularly creating a similar type of site from the factory defaults,
you should consider creating your own sets of defaults to allow you to design customer sites more
consistently and faster. This drop-down list allows you to select to use any sets of defaults that you
have created. For information on creating your own personalized set of application defaults for each
detector please see The Detector Tab of the Edit ASPIRE2 Defaults Dialog.
Fire Threshold : The amount of smoke required at the detector to activate the fire alarm (Fire 1).
Temperature : The expected average temperature at the detector. Temperature affects the viscosity
and density of air, hotter air travels faster. Enter an estimate of what the expected average temperature
will be.
Absolute Pressure : The expected average air pressure at the detector. Air pressure affects the
transport time. If you have correctly entered the altitude of the customer site you will not normally need
to adjust the absolute pressure.
System Flowrate : The amount of air collected by the detector per minute.
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Manifold Pressure : The amount of suction (in Pascals) in the detector manifold.
Total Pipe Length : This is the total length of all pipes connected to the detector. If this number is red
you will need to decrease the size of the pipe network for the detector to work effectively. Alternatively,
you can select a different Detector Type as another model may be able to support your proposed pipe
network.
Number of sample points : All detector types have an upper limit on the number of sample points
that can be effectively used. Having too many sample points connected to a detector will reduce the
sucking pressure to an unacceptable lower limit that may compromise detection.
Maximum Transport Time : This is the maximum acceptable amount of time for a smoke sample to
travel from a sample hole to the detector.
Minimum Hole Flow Rate : This is the minimum acceptable amount of air to be sampled by each
hole per minute.
Inverted Detector : For some customer sites, it may be most practical to install the detector in an
inverted (upside-down) position. Check this box if the detector will be inverted.

The Pipe Summary Tab of the Detector View

Figure 6-5: The Pipe Summary Tab of the Detector view
The pipe summary tab displays the current pipe configuration. This tab gives a summary of the pipe network
connected to the detector. As extra pipes are added you will need to select Calculate or Auto balance to
update these details. Some figures, such as the distance between holes, may vary. When this occurs the
range of distances will be displayed instead of a figure. Select the pipe in the tree view to see the details.
l
l
l
l
l
l
l
l

l

l
l

Pipe Length : The total length of pipe connected to the detector.
First Position : The distance from the detector to the first hole.
Number of Sample Points : Total number of sample holes for the pipe.
Hole Spacing : Average distance between holes.
Pipe Internal Diameter : The ID (Internal Diameter) of the pipe.
Capillary Internal Diameter : The ID (Internal Diameter) of any capillaries.
End Vent Diameter : The size of the hole in the endcap.
Maximum Transport Time : The maximum calculated transport time for an air sample to travel from a
sample point to the detector.
Ambient Pressure : The relative difference in suction pressure between the location of the sample
point and the location of the detector exhaust. If the detector exhausts air back into the same area it
samples, the ambient pressure should be set to zero (0) Pa.
Sector Pressure : The suction pressure for each pipe at the detector.
Sector Flow : The amount of air collected by each pipe.

The Group Details Tab of the Detector View
Warning: Hole Groups should not be used when trying to achieve EN 54-20 compliance. Instead, use the
Sampling Point Sensitivity tab (Pipe Type must be set to Europe).
The Group Details tab is used to create groups of sampling holes. For further information refer to Advanced
Design Using Groups.
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Figure 6-6: The Group Details tab of the Detector view
l
l

l
l
l
l
l
l
l

l

l

l

l
l

26

Add : Allows you to add a new group.
Delete : Allows you to delete a group. Holes assigned to the deleted group are returned to the Default
group.
Rename : Allows you to rename a group.
Target Aggregate Sensitivity < : The upper limit of smoke detection for the group of holes.
Target Aggregate Sensitivity > : The lower limit of smoke detection for the group of holes.
Target Hole Sensitivity < : The upper limit of smoke detection for holes in the group.
Target Suction Pressure > : The lower limit of suction pressure for holes in the group.
Target Balance > : The least acceptable balance for the group of holes.
Exclude from AutoBalance : The option allows you to protect your settings from being altered when
the AutoBalance function is run.
Pipe/Section : The details for each section of pipe in the pipe network. Click the radio button for each
hole to collect them into groups. Holes can be moved from one group to another by selecting the radio
button in the other group.
Aggregate Sensitivity : Aspirating Smoke Detectors have a unique feature that allows the detector to
collect small samples of smoke from many different sample points and check to see if the total of the
smoke exceeds the smoke threshold. If two traditional point detectors (which do not use aspirating
smoke detection) are exposed to a small amount of smoke - say one detector receives 48% of its
threshold, the other 52%, there is no way they can combine this information. But an aspirated detector
can aggregate smoke received through several holes. Aggregate Sensitivity is defined for a group of
holes. It is the uniform smoke level required at each hole (with clean air at all others outside the group)
to produce a fire alarm at the detector. For example, if you are using two pipes to protect a room, and a
third pipe to cover a return air grill, you might assign all holes in the first two pipes to the “room” group,
and the remainder to “air grille” group. Then you can ask ASPIRE2 to determine what is the aggregate
sensitivity of the room, and also the sensitivity for the air grille.
Balance : The lower limit of balance expected for the group of holes. This value is usually left fairly
close to 100 because the holes in the group should have similar characteristics. For further information
refer to The Flow Balance Needs to Improve.
Suction Pressure (least) : The lower limit of suction (in Pascals) for the sample hole.
Notes : You can attach notes to detectors and pipes. This information will be included in the
Installation Data Pack which will be printed out and given to the installers, so it is useful to include any
details that will assist the engineers to correctly identify and install the detector.
To add or edit the notes for a detector or a pipe, right-click and select Edit Notes. Enter the extra
information into the pop up window and select OK to save the details.
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The Sampling Point Sensitivity Tab of the Detector View
You must select Europe in the Pipe Type setting to view the Sampling Point Sensitivity tab.
l
l
l

Select Tools | System Defaults | Europe.
Click Save, then OK, then OK again. The ASPIRE2 program will exit.
Restart ASPIRE2.

Figure 6-7: The Sampling Point Sensitivity tab of the Detector view
l

l
l
l

l

l
l

l

Display Threshold : Check the check box to display/hide the threshold. If checked, the threshold will
be displayed and printed in the IDP. The checkbox for Fire 1 is not active because Fire 1 cannot be
deselected.
Detector Threshold Setting : The smoke level at which the detector will report an alarm.
Apply EN 54-20 Target : The EN 54-20 classification used to set the target hole sensitivity.
Target Hole Sensitivity : The maximum allowable smoke level at an individual hole in order to
achieve the detector threshold setting. This value is automatically adjusted when you select an EN 5420 target. The higher the target hole sensitivity, the less sensitive the detector will be.
Hole Aggregation (to achieve Target Sensitivity) : A hole aggregation number greater than 1
indicates that ASPIRE2 has aggregated holes in order to achieve the target sensitivity. You may
accept the design with aggregated holes (ASPIRE2 will show the pipe section values in red, and red
crosses next to the pipes in the tree view) or you may modify your design so that hole aggregation is 1.
For more information, refer to Hole Aggregation.
EN 54-20 Class Achieved : This row displays the EN 54-20 Class achieved for each threshold level.
Detector Threshold needed (to achieve Target Sensitivity) : The detector threshold setting that will
be triggered if any single hole detects smoke at the Target Sensitivity level.
Apply needed Detector Threshold? : Adjusts the Detector Threshold setting to the value that will
trigger an alarm any single hole if smoke is detected at the Target Sensitivity level.
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The Pipe View

Selecting any pipe, or section of pipe, in the project tree will display the details.

Figure 6-8: Pipe View
This panel displays all the calculated pipe details. Figures displayed in cells shaded gray are your calculated
values. If the calculated figures do not match your design criteria either select the detector and choose a
different set of application defaults, or change your application defaults.
The top of the panel has a summary of all the pipe sections that are in this part of the pipe network. The bottom
of the panel shows the details for each section.
You can customize the columns that appear on the Pipe View display. Right-click on the heading of any
column in the pipe view and click on the name of a column in the drop-down list to select or deselect that
column. Only columns that appear in the Pipe View will be included in the IDP.

Summary Information
l

l
l

l
l
l

l
l
l

Total Pipe Length : The total length of all sections of pipe. Total Pipe Length may be altered by
clicking on the relevant cell in the Relative Distance column and entering a new value. Press Enter to
enter the new value. The Total Pipe Length will be updated to show the new value.
Sector Pressure : The suction expected in this section of the pipe.
Pipe Flowrate : The amount of air expected to be sampled by this section of the pipe (liters per
minute).
Ambient Pressure : The difference in pressure between this section of the pipe and the detector.
Number of Sample Points : The total number of sample points in this section of the pipe.
Hole Diameter : This option allows you to change all hole sizes for this section of the pipe network
(holes can be adjusted manually in the table).
Capillary Diameter : This option allows you to change the width of a capillary.
Capillary Length : This option allows you to change the length of capillary.
Sector Factor : This option is only required for VLS detectors. Sector factor allows you to set different
alarm thresholds for each of the four sectors. The sector factor can be set from 0.5 to 2.0.

Detailed Information
l
l

l

l
l

28

Item : The name of each section of pipe.
Type : Type of each item of pipe in the design. You can change holes for capillaries, and bends for
elbows by clicking on the component that you wish to change and select another component from the
drop-down list.
Direction : Indicates the direction that a bend or elbow will take. For further information on the different
directions see the pop-ups by placing your mouse pointer over any item in the list.
Absolute Distance : Distance from the start of the pipe (detector).
Relative Distance : Distance relative to the previous item in the list.
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Hole Diameter : This changes the size of all sampling holes for this section of pipe. If you have a
variety of hole sizes you can set Hole Diameter to the most common size, then manually edit the other
hole sizes.
Capillary Length : This changes the length of capillaries for this section of pipe. If you have a variety
of lengths you can set Capillary Length to the most common size, then manually edit the length of the
other.
Transport Time : The time it will take for an air sample to move from the sample point to the detector.
Pressure : The suction pressure at the sample point. This should be at least 25 Pascals. Cross drafts
in the sampling area may require more suction pressure.
Flow : The amount of airflow from the sample point.
Flow% : The percentage of air flow that will come from the sample point.
Hole Sensitivity : The relative sensitivity for the sample point. Higher numbers indicate less
sensitivity.
Pipe Diameter : ID (Internal Diameter) of sampling pipe.
Capillary Diameter : ID (Internal Diameter) of the capillary. Editing this will change the ID for all
capillaries in this section of pipework. If you have a variety of IDs you can set Capillary Diameter to the
most common size, then manually edit the ID of the other capillaries.
Intersection Pressure : The pressure at the point where the capillary intersects the pipe.

6.5.4

The 3D View

To display the 3D view for a single pipe, select that pipe in the tree view. To display the 3D view for a detector,
select the detector in the tree view.
Select View | 3D View to display the 3D view.

Figure 6-9: 3D View
This view allows you to see a 3D representation of the pipe network that you have constructed. You can view
the pipe network from any of the fixed positions (isometric shown above) or use your mouse (click and drag) to
rotate the entire network in any direction you choose.
Copies of the views can be included in the IDP (Installation Data Pack) which is given to installers.
The colors used are the same as the pipe view, green is good, red requires further investigation. For further
information on the color coding refer to The Colors used in ASPIRE2.
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IDP (Installation Data Pack)

Select File | Generate IDP to see the Installation Data Pack for your site.
Once you have finished designing your site, the IDP contains all the site specific information that the installer
needs to know to correctly install your design. This information includes project level information, drawings,
pipe network specifications, and all the notes you have added to your design.
IDP Project
The first section of information is specifically related
to the project. This section of the IDP includes the
altitude above sea level, the date the IDP was
printed, and the units of measure to be used by the
project.

IDP Detector
The second section contains information about the
type and configuration of each of the detectors that
will be used on the site. The detector section also
contains a summary of the pipe networks that will be
connected to each detector.
If your Pipe Type is Europe, the IDP will include a
table showing the multiple threshold sensitivities you
have selected.
IDP 3D Diagrams
The third section contains 3D schematic diagrams for
each pipe leading away from the detector. The
inclusion of 3D diagrams is optional (but
recommended) in the IDP.
Note:

Color coding is used in these diagrams. If
there are any red sections of pipe, it
indicates that the current configuration will
not meet your design criteria and further
investigation is required before you can
send the IDP to the installer.

IDP Pipe Summary
The next section of the IDP contains a summary of
the parameters for each pipe. The figures listed in this
section may also be used by the person
commissioning the system to determine the expected
air pressure in each pipe.
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IDP Pipe Section
Finally, the IDP contains a section which gives the installer detailed information on the configurations required
for this section of the pipe network.
Details such as the expected pressure for each hole can be used by the person commissioning the system to
check that the installed pipe network matches the design created in ASPIRE2.

Figure 6-10: IDP - Pipe Section Information

6.5.6

BOM (Bill of Materials)

A Bill Of Materials can be generated for a single
detector or for the entire project. Select a detector or
the project, then select File | Generate BOM to see a
list of all the parts required for each detector in your
project.

Bill Of Materials
The first section of this report lists all the project
details.

Detector
This section of the report lists all the part numbers
required to order the parts for each detector.

Project Totals
This section of the report is a summary of all the parts
required for the entire project (if BOM is generated for
entire project).

Commissioning Report
Select File | Commissioning Report or click on the
Generate Commissioning Report toolbar button to
generate the Commissioning Report.
The Commissioning Report contains all the forms
used to commission the system.
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The Pipe Wizard

The Pipe Wizard automates the addition of new pipes to a detector. It will lead you through all of the steps
required to configure a pipe. To access the pipe wizard select a detector, then select Insert | Add Pipe. Once
you have completed the creation of a pipe, you can view the details of any pipe by selecting it in the tree view.
The Pipe Wizard knows the maximum allowable parameters for each type of detector. The Pipe Wizard will
recommend that you use a more appropriate detector if you attempt to configure a pipe network which is
beyond the recommended capabilities for the type of detector you have chosen.
If you must use that type of detector you should review your pipe runs on the floor plan and modify your pipe
network to a better design.

7.1

The Pipe Network Choice Screen of the Pipe Wizard

Figure 7-1: Pipe Wizard
Enter a name and select which type of pipe is to be added to the detector.
l
l
l

l

Simple : Pipes may have many bends but not branch into more than one pipe.
Simple branch : Pipes are used to fill in a section of a room which is not covered by other pipe work.
H configuration : Pipes are recommended for small, square rooms as they have good balance and
uses less pipe than equivalent single pipes.
Multiple Branch : Pipes are used in large rooms or rooms with odd shapes.
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The Simple Pipe Screen of the Pipe Wizard

To access the Pipe Wizard select a detector, then select Insert | Add Pipe.

Figure 7-2: Simple Pipe Screen
The default configuration settings can be modified by Tools | Application defaults | Simple Pipe Wizard.
These settings allow you to configure a pipe which may have bends but does not split into more than one pipe.
l
l

l
l

l
l
l
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Total Pipe Length : Enter the length of the pipe.
Number of bends before the first hole : Enter the number of bends before the pipe network reaches
the first sample hole.
First Hole Position : Set the distance to the first sample hole in the pipe.
Hole Separation : Set the distance between sample holes in the pipe. If you are using a variety of
different distances between holes, enter the most common distance here and manually edit the
distances when the pipe wizard has finished.
Back < : Returns you to the previous screen of the pipe wizard.
Next > : Moves you on to the next screen in the pipe wizard.
Finish : Selecting this button will cause the pipe wizard to automatically accept the default values for
any options which you have not already set.

www.xtralis.com

VESDA by Xtralis

7.3

VESDA ASPIRE2 Product Guide

The Simple Branch Screen of the Pipe Wizard

To access the Pipe Wizard select a detector, then select Insert | Add Pipe.
Legend
A

Section 1

B

Section 2

C

Section 3

Figure 7-3: Simple Branch Wizard Screen
These settings can be modified by Tools | Application defaults | Simple Branch.
These settings allow you to configure your branched pipe produced by the wizard.
l

l
l
l
l
l
l
l
l
l

Number of bends before the first branch : Enter the number of bends before the pipework will start
branching.
First Hole Position : Set the distance to the first sample hole in the pipe.
Hole Separation : Set the distance between sample holes in the pipe.
Section 1 Length : Set the length of the first piece of pipe. (A)
Section 2 Length : Set the length of the second pieces of pipe. (B)
Section 3 Length : Set the length of the third pieces of pipe. (C)
Total Pipe Length : The length of all the parts of pipe.
Back < : Returns you to the previous screen of the pipe wizard.
Next > : Moves you on to the next screen in the pipe wizard.
Finish : Selecting this button will cause the wizard to automatically accept the default values for any
options which you have not already set.

Use the Simple Branch Pipe screen to create a T piece with holes in Section B. First, create a Simple Branch
Pipe. Go to the Pipe View screen, and select one of the individual subsections sections that corresponds to
Section B. Delete this section. Repeat for the other side of the Simple Branch pipe. Use View | 3D View to
check the new pipe layout.
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The H Configuration Screen of the Pipe Wizard

To access the Pipe Wizard select a detector, then select Insert | Add Pipe.
Legend
A

Section 1

B

Section 2

C

Section 3

Figure 7-4: H Configuration Screen of the Pipe Wizard
This kind of pipe network can provide well balanced sampling for small, square rooms.
These settings can be modified by Tools | Application defaults | H Configuration.
These settings allow you to configure a H branched pipe (also called a small multiple branch).
o
o
o
o
o
o
o
o
o
o
o

Number of bends before the first branch : Enter the number of bends before the pipework will start
branching.
First Hole Position : Set the distance to the first sample hole in the pipe.
Section 1 Length : Set the length of the first piece of pipe (A).
Section 2 Length : Set the length of the second pieces of pipe (B).
Section 3 Length : Set the length of the third pieces of pipe (C).
Endcaps only : Have 4 sample points, one in each endcap.
8 Holes : This will normally consist of a hole in each Section 3 pipe, and a second sample hole in the
endcap.
Total Pipe Length : The combined length of all sections of pipe.
Back < : Returns you to the previous screen of the pipe wizard.
Next > : Moves you on to the next screen in the pipe wizard.
Finish : Selecting this button will cause the pipe wizard to automatically accept the default values for
any options which you have not already set.

To model a 4-hole configuration with the holes in Section C, choose the 8-hole configuration, and set the
Endcap hole diameter to 0 units.
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The Multiple Branch Screen of the Pipe Wizard

To access the Pipe Wizard select a detector, then select Insert | Add Pipe.
Legend
A

Section 1

B

Section 2

C

Section 3

D

Section 4

E

Section 5

Figure 7-5: Multiple Branch “Moose Head” Screen
These settings can be modified by Tools | Application defaults | Multiple Branch. These settings allows
you to configure the defaults when you add a Multiple branched pipe (refer to The Pipe Network Choice
Screen of the Pipe Wizard).
These settings allow you to configure a multiple branch pipe (also called a 'moose head' pipe).
l

l
l
l
l
l
l
l
l
l
l
l

Number of bends before the first branch : Enter the number of bends before the pipework will start
branching.
First Hole Position : Set the distance to the first sample hole in the pipe.
Hole Separation : Set the distance between sample holes in the pipe.
Section 1 Length : Set the length of the first piece of pipe (A).
Section 2 Length : Set the length of the second pieces of pipe (B).
Section 3 Length : Set the length of the third pieces of pipe (C).
Section 4 Length : Set the length of the fourth pieces of pipe (D).
Section 5 Length : Set the length of the fifth pieces of pipe (E).
Total Pipe Length : The combined length of all sections of pipe.
Back < : Returns you to the previous screen of the pipe wizard.
Next > : Moves you on to the next screen in the pipe wizard.
Finish : Selecting this button will cause the pipe wizard to automatically accept the default values for
any options which you have not already set.
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The Pipe Properties Screen of the Pipe Wizard

If you wish to use a variety of different size hole diameters then enter the most common size in the hole
diameter field and once the wizard is finished you will need to manually edit the sizes. To edit the sizes, select
the section of pipe in the tree view, click on the appropriate cell in the Hole Diameter column, and edit the size
by entering the value, or by choosing a diameter from the drop-down list.

Figure 7-6: Pipe Properties Screen
Pipe Configuration
l

Pipe Diameter : Enter the ID (Internal Diameter) of the pipe network.

Capillary
l
l
l

Use Capillaries : Check this checkbox if you would like to use capillaries.
Capillary Diameter : If you choose to use capillaries, enter the internal diameter of the capillaries.
Capillary Length : If you choose to use capillaries, enter their length.

Sampling Points
l

l

Hole Diameter : The standard size of holes in the pipe network. You can manually change the size of
individual holes once the Pipe Wizard has finished.
Endcap Diameter : The standard size of endcap holes in the pipe network. You can manually change
the size of individual holes once the Pipe Wizard has finished.

Environment
Ambient air pressure is any difference in air pressure that occurs between the sample holes and the detector.
If the pipe samples air from an area that has a higher or lower air pressure than the detector it will affect the
flow rate, transport time and other variables in your design. Differences in air pressure can be caused by fan
forced air being pumped into an area such as a computer room, cabinets that need to be air cooled, and some
high security environments.
Generally, if there are no air tight doors in a building this figure should be zero (0). If air tight doors are fitted,
ask the building management for access to the air conditioning specifications as it should show any
differences in pressure.
In computer rooms or other mechanically ventilated areas, it is possible for individual pipes to be located in
areas where the ambient atmospheric pressure is higher (+ve ambient) or lower (-ve ambient) than the
pressure that the detector is located in. The ambient pressure differential relevant to each pipe can be entered.
It is not usual for pressure differentials to exceed 25 Pascals (Pa). At this pressure, doors become difficult
either to open or to close, or loose ceiling tiles may lift. An aspirator exhaust pipe may be fitted to relieve
pressure or noise.

38

www.xtralis.com

VESDA by Xtralis
l

l
l
l

VESDA ASPIRE2 Product Guide

Ambient Pressure : Enter the pressure differential between the pipe network and the detector. This
will be zero unless there are air-tight areas between the pipe network and detector.
Back < : Returns you to the previous screen of the Pipe Wizard.
Next > : Moves you on to the next screen in the Pipe Wizard.
Finish : Selecting this button will cause the Pipe Wizard to automatically accept the default values for
any Pipe Wizard options which you have not already set.

7.7

The Edit ASPIRE2 Defaults Dialog

If you find that you are regularly creating a similar type of site from the factory defaults, you should consider
creating your own set of application specific defaults to allow you to design customer sites faster and more
consistently.
To create a new set of application defaults, open a project. Select Tools | Application Defaults, select a tab
and edit the defaults. When you have finished editing all the desired defaults on all of the desired tabs, click
Save and enter a name for the new set of defaults.
You have now created a new set of application defaults. To start using them, close the current project and
select File | New. Add a detector. On the General tab of the Detector View, select your set of application
defaults from the Application drop-down list and you are ready to start.

7.7.1

The Detector Tab of the Edit ASPIRE2 Defaults Dialog

To access this tab, select Tools | Application Defaults | Detector

Figure 7-7: The Detector tab of the ASPIRE2 Defaults dialog
Threshold levels are dependent on the local codes and authorities as well as the customer site requirements.
Thresholds may need to be altered once the results of the smoke tests have been analyzed.
l

l

l
l

Note:

Absolute Pressure : The expected air pressure for the customer site. The default is 1013 hPa which
is the air pressure at sea level. You will only need to adjust the pressure if the detector is being installed
at high altitudes.
Maximum Transport Time : The upper allowable limit of time that it can take to move a smoke
sample from a sample hole to the detector.
Minimum Hole Flow Rate : The lower allowable limit of airflow from the pipe network.
Temperature : This is the expected average temperature where the detector and the pipe network will
operate. Temperature affects the density and viscosity of air, the hotter the air the shorter the transport
time. As an example, VLP transport time for a single one hundred meter pipe run:
Temperature

-20 C

+20 C

+60 C

Transport Time

89 Seconds

81 Seconds

76 Seconds

For information about minimum or maximum operating environments for each detector please see
the VESDA Pipe Network Design Guide or refer to the manual for that detector. Transport times are
also dependent on hole sizes.
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The Group Tab of the Edit ASPIRE2 Defaults Dialog

To access this tab, select Tools | Application Defaults | Group.

Figure 7-8: The Group tab of the ASPIRE2 Defaults dialog
The use of groups is an advanced design topic that should only be used if you have received Xtralisaccredited training.
l
l
l
l

Target Endcap Sensitivity Factor < : The minimum sensitivity for an endcap.
Target Balance > : The lower limit of acceptable sample hole balance.
Target Hole Sensitivity < : The lower limit of acceptable hole sensitivity.
Target Suction Pressure > : The lowest level of acceptable suction pressure for any sample point in
the group.

7.7.3

The Pipe Tab of the Edit ASPIRE2 Default Dialog

To access this tab, select Tools | Application Defaults | Pipe

Figure 7-9: The Pipe tab of the ASPIRE2 Defaults dialog
When you run the Pipe Wizard you will be able to change any of the default values entered below.
l

l
l
l
l
l
l

Ambient Pressure : The default pressure differential between the pipe network and the detector. This
will be zero unless there are air-tight areas between the pipe network and detector.
Total Pipe Length : The default length of the pipe.
Pipe Diameter : The default ID (Internal Diameter) of the pipe.
Hole Diameter : The size of sample points in the pipe.
Capillary Diameter : The diameter of capillaries connected to the pipe.
Capillary Length : The length of capillary.
EndCap Diameter : The diameter of the vent in the endcap.

These are only default sizes, you will be able to change these figures when you run the Pipe Network Wizard,
and in the project pipe view.
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The Simple Pipe Wizard Tab of the Edit ASPIRE2 Defaults Dialog

To access this tab, select Tools | Application Defaults | Simple Pipe Wizard.

Figure 7-10: The Simple Pipe Wizard tab of the ASPIRE2 Defaults Dialog
This dialog lets you configure the default settings for the simple pipe wizard. For further details refer to The
Simple Pipe Screen of the Pipe Wizard.
l
l
l

Number of bends before the first hole : The default number of bends before the first hole in the pipe.
First Hole Position : The distance of the first hole from the start of the pipe network.
Hole Separation : The default distance between holes.

7.7.5

The Simple Branch Wizard Tab of the Edit ASPIRE2 Defaults
Dialog

To access this tab, select Tools | Application Defaults | Simple Branch Wizard.

Figure 7-11: The Simple Branch tab of the ASPIRE2 Defaults Dialog
This dialog lets you configure the default settings for the simple branched pipe wizard. For further details refer
to The Simple Branch Screen of the Pipe Wizard.
l

l
l
l
l
l

Number of bends before the first branch : The default number of bends before the first branch in the
pipe.
First Hole Position : The distance of the first hole from the start of the pipe network.
Hole Separation : The default distance between holes.
Section 3 Length : The length of the third section of pipe.
Section 2 Length : The length of the second section of pipe.
Section Length : The length of the first section of pipe.
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The H Configuration Wizard Tab of the Edit ASPIRE2 Defaults
Dialog

To access this tab, select Tools | Application Defaults | H Configuration.

Figure 7-12: The H Configuration tab of the ASPIRE2 Defaults Dialog
This dialog lets you configure the default settings for the H configuration pipe wizard. For further details refer
to The H Configuration Screen of the Pipe Wizard.
l

l
l
l
l
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Number of bends before the first branch : The default number of bends before the first branch in the
pipe.
First Hole Position : The distance of the first hole from the start of the pipe network.
Section 3 Length : The length of the third sections of pipe.
Section 2 Length : The length of the second sections of pipe.
Section Length : The length of the first section of pipe.
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The Multiple Branch Wizard Tab of the Edit ASPIRE2 Default
Dialog

To access this tab, select Tools | Application Defaults | Multiple Branch.

Figure 7-13: The Multiple Branch Configuration tab of the ASPIRE2 Defaults
This dialog lets you configure the default settings for the Multiple Branched pipe wizard. For further details
refer to The Multiple Branch Screen of the Pipe Wizard.
l

l
l
l
l
l
l
l

Number of bends before the first branch : The default number of bends before the first branch in the
pipe
First Hole Position : The distance of the first hole from the start of the pipe network.
Hole Separation : The default distance between holes.
Section 5 Length : The length of the fifth sections of pipe.
Section 4 Length : The length of the forth sections of pipe.
Section 3 Length : The length of the third sections of pipe.
Section 2 Length : The length of the second sections of pipe.
Section Length : The length of the first section of pipe.

7.7.8

The Edit System Defaults Dialog

To access this dialog, select Tools | System Defaults.

Figure 7-14: Systems Defaults
To change the units being used, open ASPIRE2 and select Tools | System Defaults, select the appropriate
tab, edit the setting, then click Save. The changes will take effect when you start a new project.
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The System Default Tab of the Edit System Defaults Dialog

This tab allows the user to configure:
The region
l
l
l
l

AsiaPac
Europe
American
Generic

Unit
This setting allows you to toggle the interface between Imperial and Metric measurements as applicable to the
region.
Design method
l
l

Hole Sensitivity
Hole Group

Enforced Limit
This setting is available when the user selected the Hole Sensitivity as the design method.
l
l

EN54-20 (show the EN54-20 hole sensitivity page on the detector view)
None

7.7.10 The User Defaults Tab of the Edit System Defaults Dialog
This tab allows the user to set the Contact Name and Installer Name for the installation. These names load up
when the user starts a new project.

Figure 7-15: The User Default Tab

7.7.11 The Detector Default Tab of the Edit System Defaults Dialog

Figure 7-16: Detector Default Tab
This tab allows the user to configure:
l
l
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Allowable Hole sizes : Allows you to enter the list of acceptable hole sizes for your project.
Altitude : The altitude above sea level affects the air pressure in the detector view. Thinner air at
higher altitudes will increase the time it takes to get a smoke sample to the detector (transport time).
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7.7.12 The Language Setting tab of the Edit System Defaults Dialog
This tab allows the user to select the language with which they would like to operate ASPIRE2.

Figure 7-17: The Language Tab
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Configuring Your Applications and Defaults

The factory default settings used when you first start the software are designed to meet Xtralis standards.
These standards are typically more demanding than many local codes and standards. You will need to check
and configure the default values to suit the local codes and standards before designing the customer site.
You will also want to configure the default settings to suit your installer and application requirements. Once
these are configured you can be confident that the software will accurately accept designs which meet the
specific requirements of your customer site.
Changing the Defaults to Comply with Local Codes and Standards
The default criteria of ASPIRE2 may not meet the parameters required by your local fire codes and standards.
Before you start building pipe network designs for customers you must check that the settings will be suitable
for the customer environment. Failure to do so may result in ASPIRE2 'approving' a design, and producing a
bill of materials, which fails to meet local codes and standards.
Refer to The Detector Tab of the Edit ASPIRE2 Defaults Dialog for instructions on how to change the default
criteria.
Changing the Defaults to suit your Installer
If your installation crews are limited to using drill pieces of certain sizes then edit the defaults so that
ASPIRE2 will only offer you solutions which comply with these restrictions. Refer to The Edit System
Defaults Dialog for instructions on how to change the default application configurations.
Creating Custom Applications
If you are regularly designing a particular type of building, say a warehouse, you may wish to set up a your
own set of defaults to suit this environment. To configure a set of application specific defaults, refer to The
Edit System Defaults Dialog.
Copying or Distributing Defaults
Once you have created a set of defaults for a specific environment you can save and send them to other
people, to ensure that everyone in your organization is using the same set of defaults.
To distribute your set of defaults, copy the default file you have created in one of the following directories and
email it as required.
l
l
l

C:\Program Files\Xtralis\ASPIRE2\regions\America
C:\Program Files\Xtralis\ASPIRE2\regions\asiaPac
C:\Program Files\Xtralis\ASPIRE2\regions\Europe

The path and folders listed above will be correct if you have installed to the default location recommended by
the ASPIRE2 installation software. If you chose to install the software into another directory then you should
look there for your default files.
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Example: How to Use ASPIRE2

The following section shows an example of setting up and troubleshooting a detector and pipes to obtain an
acceptable configuration, and to achieve EN54-20 classification. The example used here is of a VESDA VLP
detector with two straight pipes of 50m long, and two straight pipes of 40m long.
The 3D view for the detector with four pipes (below) shows the 3D view of the detector and pipes after clicking
the Calculate button. The pipes sections are colored green where the values are acceptable, and red where
they are unacceptable. The General tab shows that the manifold pressure is too low, and the group details tab
shows that the balance is unacceptable.
The aspirator speed was increased to 3600 rpm, and the Autobalance button clicked. After Autobalancing,
the hole sensitivities are colored green (Figure 9-2), indicating that the values are acceptable.
The Sampling Point Sensitivity tab shows that to achieve EN54-20 Class C, a detector threshold of 0.213 is
needed. This value is less sensitive than the current value of 0.200, so the detector is compliant.
When the display threshold checkbox is checked for Action Threshold (Class B), the maximum transport time
is reduced to 90 seconds (refer to Achieving EN 54-20 Compliance), and the values for the pipe sections are
red (The red figures indicate that the detector has achieved EN54-20 Class C but not Class B). The EN 54-20
Class Achieved box shows that Class C has been achieved.
The Apply button was clicked and confirmed, and the Calculate button was clicked. The numbers change to
green, and there are no red crosses on tree view (After the Detector Threshold needed (to achieve target
sensitivity) is applied, the detector has achieved EN54-20 Classes B and C). The detector now complies with
EN54-20 Classes B and C.

Figure 9-1: The 3D view for the detector with four pipes
Note:

Pipe sections shown in red are unacceptable.

www.xtralis.com

49

VESDA ASPIRE2 Product Guide

VESDA by Xtralis

Figure 9-2: The Sampling Point Sensitivity tab shows that the detector has achieved EN54-20 Class C
classification

Figure 9-3: The red figures indicate that the detector has achieved EN54-20 Class C but not Class B
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Figure 9-4: After the Detector Threshold needed (to achieve target sensitivity) is applied, the detector has
achieved EN54-20 Classes B and C
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10 FAQs
10.1 Pipe Layout
Question: I made a mistake while inputting data into the pipe wizard, how can I correct the design?
Answer: Click on the pipe you have created in the tree view and edit it manually.
Question: Can an end cap be a capillary drop?
Answer: You can get the same effect by, simply placing a capillary just before the end-cap and then changing
the end cap to a ‘closed’ end cap.
Question: What do I do when the "total pipe length" is red?
Answer: If the "total pipe length" is red in ASPIRE2, this means that:
this pipe is longer than Xtralis recommends for this detector based on detailed testing of the detector aspirator.
Some recommended actions to resolve this are:
l
l
l

l

Upgrade to a higher performing detector
Split the pipe into two shorter pipes.
If you are already using a VLP or VLS detector, consider redesigning the system to use additional
detectors
Check the area coverage is within the regulatory limits.

ASPIRE2 allows the user to create designs that exceed Xtralis recommended limits for the VLP or VLS
detectors. In this case, the designer must verify that the performance of the pipe network is within acceptable
customer and regulatory requirements.
Question: Is it possible for a pipe not to have an end cap in an ASPIRE2 MODEL?
Answer: There must always be an end cap, but you can represent a closed pipe by using a closed end-cap
(with a hole size of 0 mm).
You should never use an end-cap with a very large hole size because then your system will not be able to pick
up a break in the pipe network.
Question: Can I model return pipes with ASPIRE2?
Answer: ASPIRE2 does not model return pipes but assumes that the air is returned to the same system as
the inlets. So if the detector is placed in an air duct, the return pipes should release the return air back to the
duct. As always you will need to install and test them.
Question: In the pipe view, how can I change a hole to a capillary?
Answer: Select the relevant pipe section in the tree, select the hole, from the item type column and change it
to a capillary.
Question: I can’t change pipe assignments without first deleting them. What should I do?
Answer: Presumably the changes that you refer to are adding and removing joins and bends in a pipe. It is
possible to both insert new bends, Tees etc and also to remove them as described below.
To insert the bends, Tees or other items:
l
l

l

Select the pipe segment in the tree.
Select the insert position (on the table) then click on the item in the palette toolbar. ASPIRE2 will insert
the item mid-way between the selected item and the previous item.
Check the item distances are correct for the new item and the following item.

To delete an item:
l
l
l

l

Select the pipe segment in the tree.
Select the item to delete in the table.
Select the Delete Item toolbar button (the red cross) to delete. The distance of the deleted item would
be added to the distance of the next item.
Check that the item distance for the following item is correct.

Question: How can we change the order of a pipe/pipe section?
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Answer: You can change the order of sections within a pipe or pipes within a detector using drag and drop on
the tree. The drag and drop allows items to be reordered under their parent item but does not allow items to be
moved to another parent.
Question: Is it possible to copy pipes and/or detectors within ASPIRE2?
Answer: The user can copy and paste pipes, within the same design, as long as the detector has not reached
its pipe limit.
You duplicate a detector by selecting it, copying it to the clipboard (using the copy toolbar button or using Edit>Copy menu or Ctrl-C keyboard shortcut). Then select the project on the tree and paste the detector into the
project (by clicking the paste toolbar button or using Edit->Paste menu or Ctrl-V keyboard shortcut).
To copy a pipe, select it, copy it to the clipboard, select the destination detector and paste. The paste function
will be disabled when the detector’s pipe limit has been reached.
Question: How could I copy one pipe over another?
Answer: Select the original pipe then click on the copy icon. Select the destination pipe then click the paste
button. ASPIRE2 will replace the destination pipe with that from the clipboard when you click OK to proceed.
Question: How do I delete a pipe section or Tees and Branches?
Answer: To delete a pipe section, select it on the tree and then use the Edit > Delete Section menu. You can
also right mouse click and select Delete Section from the context menu. ASPIRE2 will then delete the pipe
section and replace the branch at the head of the section with a bend or elbow.
To delete a branch (or Tee) you will first need to delete one of the pipe sections which will replace the branch
with an elbow as described above. You can then delete this elbow by selecting the pipe section in the tree,
selecting the elbow in the table and using the Delete Item toolbar button (the red cross).
Question: An entire screen in the pipe wizard is dedicated to ambient pressure. How do I make sure I enter in
the right value for the application?
Answer: If there are no airtight doors in the pipe or detector areas set this value to zero (0). If there is fan
forced air or air doors fitted check with building management for the air pressure specified in the air
conditioning floor plans.
Question: How do I change units to imperial, the field is greyed out?
Answer: Only when Pipe type = American do you have the option to change between Imperial and Metric
units. Bring up the System Defaults window using the Tools > Systems Defaults menu and change the Units
field to Imperial. Save and restart ASPIRE2.
Question: I would like to view all possible hole size choices how can I do this?
Answer: Open ASPIRE2, select Tools | System Defaults | Allowable Hole sizes and enter all the required
sizes. You will need to do this before starting work on a project.
Question: How do I choose my local pipe?
Answer: Contact your local Xtralis office or check your local codes and standards.

10.2 3D View
Question: How do I invert my detector so that it shows up correctly on the 3D view?
Answer: To invert the detector you need to select it on the tree and then on the General tab on the right pane
you will find an Inverted Detector checkbox below the group of properties on the right of the tab. Use this to
define the detector orientation.
Question: What can I do if I cannot see the 3D view in ASPIRE2?
Answer: If selecting 3D view in ASPIRE2 makes your computer screen flash and display a blank window or
you get an error message of "insufficientmemory" or unexpected 3D error message, the following steps will
optimise the 3D view function in ASPIRE2:
1. Ensure that you have the most recent driver for the video card in your computer.
2. Reduce your computer "hardware acceleration" from 100% to 40%. (You can do so from the Control
panel - Display - Advanced. Select the "Trouble shoot" tab and change the sliding scale for hardware
acceleration).
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Note that To function fully, ASPIRE2 requires support for Java3D version 1.3.1. Some limits may be imposed
by your video card and drivers. Click here for further information on supported video cards.
Question: How could I see what I have just created?
Answer: ASPIRE2 provides live 3D view update at the pipe level only. If you select the pipe then select 3D
view and keep it open. Any changes to the pipe assignment will also update the 3D view.

10.3 Flow Calculations
10.3.1 Balance
Question: Why is it important to have a balanced pipe network and how is this achieved?
Answer: A balanced system is one where there is similar flow through each sampling hole so that the entire
protected region is being monitored uniformly. We want to avoid networks which have dead regions that are
poorly monitored. In ASPIRE2, the default flow balance is 70% (and this can be adjusted). This means that
every sampling hole has at least 70% as much flow as the best sampling hole.
So how do we achieve similar flows through each sampling hole. A simple starting approach may be to make
all the holes the same size. However the flow rate through each hole reduces with distance of the hole from
the detector. To help achieve a balanced system, try increasing the sampling hole size as the holes get further
away from the detector.
Question: Is perfect pipe network balance really necessary since the regulations only stipulate transport
time?
Answer: Transport time is certainly important but if a network is not well balanced then it means that there are
‘dead’ regions that are not being fully monitored. So both balance and transport time are important. The
designer must ensure that the transport time requirement is met and complies with the regulations and also
verify that there is an overall system balance.
Question: Can I change the acceptable thresholds for % balance?
Answer: Balance should be as close to 100 as possible. However, you can set your acceptance level. To
alter your defaults see Tools > Application Defaults > Group > Target balance.
Question: Can I accept a pipe network design when some of the parameters are shown as red even after
optimising the ASPIRE2 design?
Answer: ASPIRE2 estimates the pipe network performance. Where parameters will ensure the most reliable
performance these are shown in green. Parameters appearing in red indicate that the network falls outside of
the recommended range. However, you may still accept a design with red settings if the pipe network design
meets your installation and regulatory requirements. Contact your local Xtralis office should you require further
assistance.
Question: What causes AutoBalance to fail?
Answer: AutoBalance searches for a solution to your pipe design that has acceptable transport times to all
the holes, achieves reasonable flow rates and pressures at each hole and is balanced.
If the network is inherently unbalanced such as one that combines long and short pipes then it may be
impossible to satisfy all the constraints and so the only way then to meet approved standards would be to
even out the pipe network so that all the pipes are of similar length.
With long pipes it is difficult to meet the required transport times for the holes at the ends of the pipe. The
options are generally to increase the fan speed or reduce the pipe length by relocating the detector.
ASPIRE2 may find a potential solution but still show some hole sensitivity values in red. This indicates that
the detector threshold (which drives the Aggregate Sensitivity) is not achievable for these holes. In this case
review the threshold levels and consider reducing them.
Question: I don’t like the changes that AutoBalance has made to my pipe network and wish to undo them and
go back to what I had before I ran AutoBalance. How do I do this?
Answer: The AutoBalance changes can be reversed by selecting the Tool > Reject Configuration menu
item.
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10.3.2 Calculation Parameters
Question: What is an acceptable transport time?
Answer: Most local codes and standards specify that the transport time cannot be longer than 90 seconds.
(Check your local codes for details). Xtralis recommends that the transport time should be around 60 seconds.
Remember that there can be additional delays once a fire panel is notified before an alarm is sounded so it is
important to keep the detector delay to a minimum.
Question: What can I do if the detector flow rate is too low?
Answer: You can either try to adjust the pipe network to match the detector or match the detector to better
match the network.
Where possible try using more pipes of shorter length. Alternatively, try using larger holes, but be aware that
this will tend to unbalance your system.
You can enhance the detector by increasing the aspirator speed (applicable only to detectors with adjustable
aspirator speed). If that is still insufficient then select a higher performing detector.
Question: What does it mean when the sample hole sensitivity is displayed in red?
Answer: The hole sensitivity is an indication of how high the hole smoke concentration must be in order to
cause the detector to alarm. When the sample hole sensitivity is shown in red it indicates that the smoke
coming through that hole will be diluted too much by other air flows to trigger the detector.
To resolve this issue the Fire threshold setting can be reduced or the Target Hole Sensitivity setting on the
Group tab of the Application Defaults can be adjusted.
Question: Why is the hole sensitivity shown as red above 6.092 %obs/ft or 20 %obs/m?
Answer: The maximum target aggregate sensitivity allowed in ASPIRE2 is 6.092 % obs/ft or 20 % obs/m.
This is the least sensitive that a point detector is allowed to be by any regulatory body. Given that sampling
points are often discussed as replacements for point detectors, this constraint ensures compliance. If it is
necessary for the designer to install a system that does not meet the criteria, the designer must verify that the
performance of the pipe network is within acceptable customer and regulatory requirements.
Question: How do I find out what variables mean?
Answer: Most of the variable fields have a tool tip that explains their meaning.
Question: Can I export the calculated data in pipe table data to Excel?
Answer: ASPIRE2 supports exporting data from the Pipe Table to Excel. To do this select the rows in the
table by clicking in the first column on the pipe table view and then dragging to the end, or just press Ctrl-A to
select all the rows. Select Ctrl-C to copy then paste it in Excel. Please note that this does not include the table
heading.

10.4 IDP
Question: There are empty spaces in the pipe detail table in IDP report. How do I hide them?
Answer: To hide the empty detail or unrelated data (for example, you don’t want to see capillary related
column when you design the normal sampling point network), right click on the pipe detail table header then
deselect the field you don’t want to display. This action will hide the column on the table and also on the IDP.
Question: I only want to print the pipe data. How do I do it?
Answer: You can select the preferred pipe then select the print IDP function to print the information related to
the selected pipe. If the detector is a Scanner then Scan mode data for the pipe will also be printed.
Question: How can I store a reference to the original drawings for my network?
Answer: Use the Notes field on the Project or Detector in the tree.
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10.5 Installation
Question: With which operating systems is ASPIRE2 compatible?
Answer: Microsoft Windows XP and Windows Vista (for ASPIRE2 builds greater than 3950).
Question: Do I need Administrator rights to use ASPIRE2 software on my PC?
Answer: You only need Administrator rights to install ASPIRE2. For older builds (before build 3950) you will
also need it to register the software. Once you have done this you can use ASPIRE2 without being logged in
as an Administrator

10.6 Support
Question: Where can I obtain part numbers?
Answer: Contact your local distributor or Xtralis office to request the price list or sales brochure for your
product model number.
Question: Are there any specific training courses for maintenance and troubleshooting?
Answer: All Xtralis fire systems should be installed, configured, commissioned and maintained by an Xtralis
accredited person.
Question: Where can I obtain product specifications?
Answer: Contact your local distributor or Xtralis office.
Question: How do I test the Xtralis fire system after installation?
Answer: Only Xtralis accredited personnel are permitted to install, configure, commission and maintain
Xtralis products. The Maintenance section of the System Design Manual contains performance tests for this
purpose. Local regulations should be checked for commissioning requirements. Customers may also have
predefined requirements. All results should be recorded and signed off by commissioning staff, the end user
and a local fire approval inspector. These results should also be kept on record.
Question: Where do I obtain the ASPIRE2 Product Guide?
Answer: ASPIRE2 contains a complete online help file.
Question: Where do I obtain ASPIRE2?
Answer: It is free for download from www.xtralis.com.

www.xtralis.com

57

VESDA ASPIRE2 Product Guide

VESDA by Xtralis

This page is intentionally left blank.

58

www.xtralis.com

VESDA by Xtralis

VESDA ASPIRE2 Product Guide

Index

rename

3
3D diagram

30

3D view

19, 29, 35, 49, 54

A
aggregate sensitivity

detector name

24

detector tab

39

detector type

24

detector view

7, 24

display threshold

27

display thresholds

49

download ASPIRE2
25

aggregation

44

altitude

24, 30, 44

amber/orange

18

ambient pressure

25, 40

edit menu

apply

27

endcap

8, 11, 15, 18, 20, 25, 49

11

EN 54-20
end vent

autobalance

43, 47

effective design

47
15, 24

19

edit system defaults

applications defaults
aspirator speed

5

E

12, 27

allowable

7

11, 16, 25, 27, 44, 49
25
24-25, 36, 38

diameter

40

usage

24

example

49

B
balance

F

15, 25, 33, 49, 55

bill of materials (BOM)

9, 31

features

4
19

black

18

file menu

blue

18

first position

25, 34, 36-37

9, 31

flow balance

15, 55

BOM

C
capillary

G
25, 53, 56

diameter

general tab

24, 54

38, 40

green

25

group

length

38, 40

add

25

classes

11, 49

delete

25

rename

25

internal diameter

colors

18

commissioning report
copy

19, 31

group details tab

25

7-8, 18-19, 27, 54

group sensitivity

15

group tab

40

groups

13

D
defaults 7-8, 11, 18, 20, 34-37, 39-40, 44, 47, 55
design method

delete

www.xtralis.com

H

44

detector
add

8, 18

7, 22

h configuration wizard tab

42

help menu

20

19

59

VESDA ASPIRE2 Product Guide

hole

VESDA by Xtralis

53

diameter

8, 16, 53

group

44

sensitivity
hole aggregation
hole diameter

8

30

insert menu

20
3, 5, 13, 57

installation data pack 3, 7, 9, 12, 19, 22, 30, 56
17
25, 54

20, 45

M
menus

19

minimum hole flow

16

minimum hole pressure

16

multiple branch wizard tab

43

multiple threshold level

11

multiple threshold sensitivity

12

N
note
add

7

notes

7, 22, 25, 30, 56

P
paste
paste insert

8, 22, 54

hasp

22

holes

4, 8, 15, 27, 34-35

internal diameter

25

joins

53

length

9, 15, 24-25, 34-35, 37, 40, 53, 55

moose head

37

network

4, 7-8, 15, 17-18, 20, 22, 34, 38,
47, 53, 55-56

reducer

8, 22

rename

7

select

7

bends
branch
60

22

type

4, 33

wizard

7-8, 33-38, 40, 53

pipe section

31

pipe summary

30

pipe summary tab

25

pipe tab

40

pipe view

8, 28, 53

pipe wizard

33

pressure
absolute

24

ambient

38

atmospheric

38

manifold

24

print

56

problems

15

project

7-8, 17-18, 30, 44, 54, 56

add detector

7

rename detector

7

19, 22, 53

project tools

31

7, 18-19, 27, 54

project view

23

19

R

pipe
add

8-9, 38

T piece

local codes and standards 4, 11, 15, 47, 54, 56

palette toolbar

elbow

size

L
language

19, 53

direction

IDP (installation data pack)

inverted detector

delete

12, 27

22, 56

interface

54
8, 15, 38, 40

I

installation

copy
diameter

34, 37

IDP

22

16, 44
11, 20, 38, 40, 44

hole separation

capillary

7-8, 22, 35
4, 7-8, 22, 33, 35-37, 53-54
4, 8, 33, 35, 37, 54

red
region
running ASPIRE2

8, 18, 30, 49, 53
44
5
www.xtralis.com

VESDA by Xtralis

VESDA ASPIRE2 Product Guide

S
sampling point

22

sampling point sensitivity

27

sampling points

8

save

7, 9, 47

save as

9

sector flow

25

sector pressure

25

sensitivity

8, 11, 13, 15-16, 24, 27, 49, 55

shortcut toolbar

19, 21

simple branch wizard tab

41

simple pipe wizard tab

41

site survey

3, 8, 11

suction pressure

25

support

57
7-8, 20, 44

system defaults
system specification

5

T
target aggregate sensitivity

25

target balance

25

target hole sensitivity

11, 16, 25, 27

target suction pressure

25

temperature

24

threshold

4, 16, 27, 30, 49

toolbars

19, 21

tools menu

20

training

57

transport time

7, 11, 15, 24-25, 49

tree view

8, 17-18, 53

U
unit of measure

44

updating ASPIRE2

5

upgrading ASPIRE2

5

V
version of ASPIRE2

20

view menu

19

views

23

www.xtralis.com

61

VESDA ASPIRE2 Product Guide

VESDA by Xtralis

This page is intentionally left blank.

62

www.xtralis.com

